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Welcome

Trust Tax allows you to complete a trust's tax return for a client by entering the data directly onto
the tax return on-screen. You can easily enter figures for multiple tax years and also maintain
multiple sets of figures for each year. This will allow you to print and compare slightly different
versions of the return.

Workflow for producing a tax return

Create a client

Trust Tax deals with Sage Taxation clients of type trust. Trust clients can be created directly in Trust
Tax or in Control Centre. All required details, such as name, address, tax district, UTR and lists of
partners can be entered using the Add New Trust Wizard . Later, details can be reviewed and
changed using the Main Details form.

Create a tax year

When you create a client you must specify the tax year that you want to work on for them. You can
subsequently set up multiple years for the client by performing a year update. You can produce a
tax return for any year that you create and also easily swap between them in the Tax Return
Viewer.

Enter tax data onto the tax return

Tax data is typed directly onto the tax return on-screen using the Tax Return Viewer. The Navigator
allows you to swap between pages in the return, add extra pages and remove unnecessary ones. If
you wish, you can create multiple sets of tax figures for the year and use the Navigator to choose
which set to display on the return in the Tax Return Viewer.

Print the tax return
You can print as many copies as you like of the tax return for yourself and your client before printing
a final copy.

File the tax return

The final stage is to mark a set of the client's tax return figures as filed. This is a useful indicator for
yourself and other users, since it informs you that work on the client's return for that tax year is
complete. You should only do this when the return has actually been submitted to HM Revenue &
Customs.
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Creating clients

There are three ways to create a client that can be used in Trust Tax:
e Creating a trust in Trust Tax will automatically create that trust in Sage Practice Solution
(together with any trustees as relationships).

If you use Sage Practice Solution and have client integration enabled, clients created in any
Sage Taxation program will automatically be available in Sage Practice Solution.

e Using Control Centre, you can set up clients for any program in Sage Taxation.

e Creatingclients in Sage Practice Solution gives you the benefit that your details will be
available to all of the subscribed service programs for the client. If you use Sage Time and
Fees, this will also allow you to create jobs and record time against your clients.

Connecting with Sage Practice Solution

Sage Practice Solution allows you to manage your clients’ details, link to other Sage products for
practice, record time against work carried out for them and create invoices based on that time.

The software comprises two elements:
= Practice Hub
= Time recording and invoicing
Your licence agreement with Sage will determine which elements are available.

Sage Practice Hub is the central store for your client data. You can use Sage Practice Hub to connect
your Sage Programs, for tasks, communications, reporting, letter writing etc.

We refer to Sage Practice Hub with Time recording and invoicing as Sage Practice Solution.

More information

For more information about connecting your Sage programs with Sage Practice Solution, start Sage
Practice Solution (v1.5 or above) and from the Help menu choose Contents. When the Help system
appears, use the table of contents to find the book Connecting your Sage Programs.
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Create a client

10.
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From the File menu, choose New. The New Trust Wizard appears.

Note: If you have more than one dataset, you will need to specify which dataset to add the
client to.

Click Next.

Enter the Trust name, Correspondence name, and Report name. Click Next.

Enter the contact and tax details then click Next,

Add trustees to the trust. You can either add existing clients to the trust or add new ones.
Click Next.

Provide a client code. Trust Tax will suggest one but you may want to tie this into an existing
scheme in your practice. Fill in the rest of the page then click Next.

Select the first year you will be entering tax data. Click Next.

Select which staff members to assign to the client. Click on the magnifying glass button to
see a look up window. Click Next.

Choose whether to password protect the client and whether to include in reports. Click Next
then Finish to create the client.

For more detailed information about each page of the wizard, click Help on the wizard as you create

the client.
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Main Details

Every client in Trust Tax and in the Sage Taxation has a Main Details form. You can use it to enter
and change personal details about a client and to establish their rights and identity within Sage
Taxation.

You do not have to complete all of the details in the Main Details form, but we strongly advise that
you enter as much as possible. Certain information appears on the tax return and main details
information plays an important part in the creation of Sage Taxation reports and letters.

Open the client's main details

You can open the Main Details form for the currently selected client in the following ways:
s From the File menu, choose Main Details; or

s Click Details on the Toolbar.

The name and code of the client is displayed in the title-bar of the form.

Change the client's main details

The Main Details form for clients in Trust Tax has seven pages of information. A lot of the
information is entered during the creation of the client in the Add New Trust Wizard . You can use
the Main Details form to view those details and make changes to them if necessary. You can also
enter additional information about the client which was not required during their creation.
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Tax Return Viewer

The Tax Return Viewer is your centre for managing Tax Returns and the submission process. The
viewer will appear slightly different for years 2008 and later.

I's Bakers (BAK100) - Sage Trust Tax - w1

Flze  View Retun Tools Help
NN =i A H 8 4 4w
i Open Trustees Detals Notes Tasks Save As PDF Print Next Page Next Sch. Validate -
SA900 Tax Return B o ~
Final on 27/08/2008 a 16:13 L]
i ——— The toolbar has
Tods | Find key tasks tevenue b Navigation and frequently
221 Edit trust's details stoms Tax Retu d opti 2008
L here used opuons
&5 View trustees’ details
@Vﬂlﬂae retum refenence
(= Stant submission process N Isstae auldiess
| J%Copy retum for amendment * .
— 35 Willow Strast
Farms Ash Farm
& [ Trust and Estate Tax HM Revemue & Custom: i
) 2 e 5
[ Page M5 3D
[£] Page2
H E"‘*i Access pages of
age
i Page5 the return here
| Page6 The pages ofthe return will
L Teephone be shown in this large
| review area
[0 Paged Please read th, p
[] Page 10 .
(] Page 11 mreuh your Tax Beeurn
[[] Page12 his Notiee requives you, by law: to s Make sure your payment of any tax the trust or
- [& Trust Tax Calculation Guide a Faw Retun containing details of your estate owies reaches t_as by Jll}ﬂf-ltlfujn' MS'
income and capital gains, tagether with any Oeherwise you will hawve to pay interest, and s
documents requested. for the year 6 April 2007 Possibly & sucharge.
FDF Attachmenis fo 5 April 2008. We have serd you this paper farm The Trust and Estate Tax Retum may be checked,
to W in, but you can aiso e the Tax Return Thre are peralties for supplying false or incamplate
online wsing our intermet service (using 3ra party infarmation
commesncisl softwane) Caleudating the trust or estate’s tax
Make sure the Tax Return, and any documents Fou can engose (0 caaiate the St or SSLAE'S Lax. Bt if
we ask for, reach us by: YO do Nt wani 10, and provading we recele the Retur
= 37 October 2008 if you wan! us to calculate ny.?rm«anmmmn:»meh,urnm
the trust or esiate’s tax or & you file & paper ot yous kv i e iy Lo o ey iy 17 Jeagey 200
Tax Rotnt, o both. o Howwsr, if you o keter thar 31 October 2008 o
. lanuary 2009 onling. thron moniie affer ihe dote this Notice wers given, see the
1 i you file the Returm ' Tax Catcudiation Gantde fsenl with ths Rt cniess we
Whichever method you choose, the Tax Return e s S @ L achviser) b
User: Test User Tax year: 2008 Page 1 Zoom: 74% I Read Only |

Menu
You can access all the functions of the Tax Return Viewer from the menu. Many of the options will
also be available in the Tasks pane.

s Bakers (BAK100) - Sage Trust Tax
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Toolbar
The most popular functions are available on the Toolbar. You'll find many of these options repeated
in the Menu or the Tasks pane.

akers (BAK100) - Sage Trust Tax

File  View Return Tools Help
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Open  Trustees Details  Motes  Tasks

Tasks
The most common tasks you're likely to use are available in the Tasks pane. Click on a task to start
each process.

Note: The actual tasks available to you are dependent on your access rights in Sage Taxation. If
you click on a task and see a message about increasing your access rights, speak to your
administrator.

&% Bakers (BAK100) - Sage Trust
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Forms
The Forms pane is an easy method of moving through the Tax Return. Click on a page to jump
straight to that page.
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This pane will list all the PDF files that you have attached to this return.
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Tax Return
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The page of the Return being viewed is displayed in the large preview area. Use the scrollbars to
move through the page being displayed.
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Working with multiple returns

When you create a client in Trust Tax they will only have one set of figures available. At any point,
you can create a copy of the client's tax return figures. You will then have several sets of figures for
the client.

Once created, each of these copies are independent of each other and can be edited separately. You
can choose which set of figures you want to display on the Return in the Tax Return Viewer and on
the printed version.

You can create as many copies of the figures as you like. You can delete any copies that you no
longer unless it is the only set of figures available for the client for the currently selected tax year.

Copy a set of figures

1. Select the set of figures to copy by previewingit.

2. From the Return menu, choose Copy Figures. The Copy Figures window appears.
3. Enteraname forthe copy.

4. Click OK.

Create a blank set of figures
1. From the Return menu, choose New Figures. The Enter a new name window appears.

2. Enter a name for this set of figures.

3. Click OK.

Rename an existing set of figures
1. Select the set of figures to rename by previewing it.

2. From the Return menu, choose Rename Figures. The Rename Figures window appears.

3. Click OK.

Delete a set of figures
1. Select the set of figures by previewing it.

2. From the Return menu, choose Delete Figures. A confirmation box appears.

3. Click OK to delete the figures and all the data you've manually entered in that set.

Editing returns

You can edit the figures directly in the Tax Return Viewer.

You cannot edit a return once you have started the submission process.

To edit a Return:

1. Preview the copy of a return or final return.

2. Browse to the page of the return containing the information that you want to edit.
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3. Click on the box that you want to edit.

4. Enterthe new value for the box and press Return on your keyboard.

Additional advice on editing returns

Change the main details information that appears on the return

Information is entered automatically into certain boxes, based on data that you have entered in the
client's Main Details form. You won't be able to click on the return to change this information.
Instead, open the client's main details by clicking the Details button on the toolbar.

To enter figures or text into a box:

1. Click the box so that the cursor appears.

2. Typein the text or figures that you want to appear in the box.

Ticking boxes
Some sections of the tax return require you to tick a box to indicate which of several options applies
to the client.

Click a box to tick it or clear an existing tick.
Tabbing between boxes

To move the cursor to the next box on the tax return, press the Tab key. To move the cursor to the
previous box on the tax return, press Shift+Tab

Managing tax returns

As well as navigating through the tax return, you can also use the Tax Return Navigator to manage
the pagesin a client's tax return.

You can delete unnecessary pages from the client's return. Pages that are required by HM Revenue
& Customs cannot be deleted.

You can copy any page in the return for which you may need to complete additional copies for a
client. This occurs when there is not sufficient space to enter all the client's details. You can also add
pages to the client's return by selecting one from a list of those available.

Add a schedule to the return
To add a schedule with the pop-up menu:

1. Right-click the Navigator.

2. From the pop-up menu choose Add Schedule then the schedule to add.
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To add a schedule with the main menu

1. From the Return menu, choose Add Schedule.

2. Choose the schedule to add from the sub-menu.

Note: If the Add Schedule option is greyed out, it may be because you have imported the figures
from Business Tax. In this case, you must first copy the figures before you can add additional
schedules.

Delete a schedule
1. Right-click the Navigator.

2. From the pop-up menu, choose Delete Schedule, then the name of the schedule you want
to delete.

Saving changes to the tax return

You can save changes that you have made to the tax return at any point. This is most useful if there
are multiple users working on the client's Return. You must save changes before other Sage
Taxation users can view the updated figures.

Note: Your changes are saved automatically when you close the client or TrustTax.

To save changes using the toolbar, click Save on the toolbar.

Finding and correcting errors with the return

Trust Tax can validate the client's tax return to check for errors and missing information. These
validations are performed according to rules set down by HM Revenue & Customs.

Once the return has been validated, any errors will be displayed on a Validations tab. You can click on
an error to jump directly to the problem area on the tax return and correct it.

You can also print out a list of errors for easy reference.

10
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To find errors within the return:
1. Preview the return you want to check for validation errors.

2. From the Tasks pane choose Validate Return. The return is checked for validation errors.

3. Ifany validation errors are found, a list is displayed beneath the Tax Return preview.

To correct errors within the return:
1. When errors are displayed in the Validations tab, double-click on an error to go to the
problem box on the tax return in the Tax Return Previewer.

2. Click in the box to edit the figures to correct the error.

3. When all errors have been corrected, re-validate the return by choosing VValidate Return
from the Tasks pane.

To print errors within the return:
1. When errors are displayed in the VValidations tab, right-click and choose Print Validation
Errors. A Print window appears.

2. Choose your printer settings and click Print.

Automatically calculate figures on the return

Some boxes on the return are calculated automatically based on the values of other boxes. Trust
Tax will by default automatically calculate these boxes. You can however, override the
autocalculation and enter a figure manually.

Turn off autocalculation
Boxes with a yellow highlight have autocalculation turned on.

1. Click in a box with autocalc turned on. A message appears asking if you'd like to enter a
figure manually.

2. Click Yes.

3. Enteryour new figure.

Example of a box with autocalculation enabled

34 B Clickin the box to turn
off autocalculation and
m £ entera figure manually

total of boxes 3.2 to 3.7

m £ 1,000.00 38 B 1,000.00

Turn on autocalculation
Boxes with a red highlight have had autocalc disabled.

11
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1. Right-click a box with autocalc disabled.

2. Choose Autocalculation. A confirmation message appears.

3. Ifyou're happy to lose any figure you've entered in the box, click Yes.
4

Autocalculation will be enabled for that box.

Example of a box with autocalculation disabled

m E 1.000.00

m - Right-click the box and
m ¢ choose Autocalculation
to turm it back on

m
total of boxes 3.2 to 3.7
m £ 1,000.00 38 b 2,000.00

Attachments

From November 2006 the HMRC Online Service for Self Assessment will accept PDF files as
attachments to Self Assessment Returns submitted online.

You can add PDF attachments for Self Assessment returns for 2007 and later to FBI and paper
returns using the Attachments window. To open the Attachments window, click Add Attachment in
the PDF Attachments pane.

There may be HMRC Special Cases that require attachments to be sent with the return. See Special
Cases and Exclusions in the Help for more information.

To add a file
1. Click Add. The Open window appears. The default location for this window to open to will be
the default PDF location as set in Control Centre.

2. Choose afile and click Open. The file appears in the list.
3. Repeat to add further PDF files.

Note: You can only add PDF files. You can add any number of PDF files, but HMRC Online can only
accept 20 files. The total size of the selected PDF files cannot exceed 5MB (the size of the files
selected will increase slightly when they are added as they will be encoded for security). Encrypted
or Password Protected PDF files will not be accepted by HMRC Online.

To remove a file
1. Highlight the file you want to remove in the list.

2. Click Remove. Awarning message appears.

3. Click Yes. The file is removed.

12
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To view a file

1.
2.
3.

Select the file you want to view in the list.
Click View. The file is opened in a PDF viewer window.

When you have successfully created your final return and it has a status of 'Awaiting
Approval', 'Ready to Submit' or 'Submitted', the attachments will be View only.

A list of the files added to an online submission will be included in the Additional Information box of
the SA900.

Finalise return

Prior to submitting a return you mark a set of figures as final. This makes the return read-only so will
prevent you making any further changes to it. If you find that changes are needed, you can click
Copy return for amendment from the Tasks pane and discard this set.

v A wnN

From the Return menu choose Finalise Return. The tax return is validated.

Note: If validation errors are found, you will be warned but will still have the option to finalise
the return.

The Finalise Return window appears.
Enter a name for the final return or leave the suggested one.
Click OK.

The return will be marked as final and opens in the preview.

13
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Submitting the return

You can file your return either by paper, or online.

File a return by paper

If you choose to file by Paper, you (or your client) will print out a copy of the Return for filing.

When using this method, it's not necessary for the Return to pass all validations. Personal Tax will
allow you to mark the Return Filed even though it failed some of the validation rules. We
recommend that you ensure the Return has passed validation prior to filing.

Send the return to the client:

1.
2.
3.

Open the copy of a return or final return.
In the Tasks pane click Start submission process. The Submission Wizard appears.

Choose File on Paper.

Note: If the return has failed validations, File on Paper will be the only option available.

Click Next. The Send Return to Client page appears.

If you haven't already sent the return to the client for them to sign, you can either print the
return or save as PDF and send to them via email for them to print out.

Enter the date you sent the return to the client.
Click Next.
Note: At this stage, you will have sent the return to the client and will be waiting for them to

review and sign the return. Personal Tax expects you to close this wizard and continue with
it when you receive approval from your client.

Click Close.

When the client approval has been received:

1.
2.

Open the copy of a return or final return.

Click Continue submission process. The Submission wizard appears.

Tip: Make sure you're on the Client Approval page.

Select Yes and enter the date of acceptance.
Click Next. The Submit Return to HMRC page appears.

Enter the date you submitted the return.

14
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6.

7.

Click Next,

Note: At this stage, you will have submitted the return to HMRC and will be waiting for a
submission response. Partnership Tax expects you to close this wizard and continue with it
when you receive a response from HMRC.

Click Close.

When a response has been received by HMRC:

1.
2.

Open the copy of a return or final return.

Click Continue submission process. The Submission wizard appears.
Tip: Make sure you're on the HMRC Response page.
Enter the date of the response.

Click Next. The status of the return changes to submitted.

Click Close.

File a return online

This topic explains how to submit a return online. If you're going to submit on paper, see File a
return by paper on page 14.

Before you begin

= Your practice must be registered for FBI with HMRC.

m Make sure you've entered your HMRC User ID and password. From the Return menu,

choose Online Filing > Online Filing Credentials

To file online:

1. Open the copy of a return or final return.

2. Click Start submission process. The Submission Wizard appears.

3. Choose File Online.
Note: If the return has failed validations, File on Paper will be the only option available.

4. Click Next. The Send Return to Client page appears.

5. Ifyou haven't already sent the return to the client for them to sign, you can either print the
return or save as PDF and send to them via email for them to review.

6. Enterthe date you sent the return to the client.

7. Click Next. The Client Approval page appears.

8. Click Yes and enter the date of acceptance.

9. Click Next. The Ready to File page appears.

10. Click Close.

15
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11. Choose Return > Online Filing > File Return. The Online Filing window appears.

Note: If there are returns available to file from more than one year you'll be able to select
and process the earlier years before moving on to the later years.

12. Select the return to file then click the arrow button to move the return to the Returns to file
list.

/& Agent Filing: File Returns From Davies & Collinson Smoke
gl Sort By Code % Delste @ Help 0 Cloze

Select p— thelltlbtaand Lige the arrow buttons bo move them
list. Th ht hand list will be filed to the HM Reven
There SEIE?Dtr%fEREtum ne HM Revenue & Cuztoms server.

R eturns awaitingM Returms to file

o _thenclick here
l to move it to the
» Returnsto file list

13. Click File. Progress bars appear showing the submission status.

Online Filing

Checking for rezpange [1 remaining]
FEI K.ing. Stephen, Mr. [KINT00] - 20038

Y -1 2

Progresz update due: b zeconds.
Eztimated time until all rezponzes received: less than a minute.
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